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1. Einführung
Sehr geehrte Kundin, sehr geehrter Kunde,
Vielen Dank für den Kauf dieses Produkts.
Dieses Produkt erfüllt die gesetzlichen nationalen und europäischen Anforderungen.
Um diesen Status zu erhalten und einen sicheren Betrieb zu gewährleisten, müssen Sie als Anwender diese 
Betriebsanleitung beachten!

 Diese Bedienungsanleitung ist Teil dieses Produkts. Sie enthält wichtige Hinweise zur Inbetriebnahme und 
Handhabung. Bedenken Sie dies auch, wenn Sie das Produkt an Dritte weitergeben. Bewahren Sie diese 
Bedienungsanleitung daher zu Nachschlagezwecken auf!

Bei technischen Fragen wenden Sie sich bitte an:
Deutschland: www.conrad.de
Österreich: www.conrad.at
Schweiz: www.conrad.ch

2. Symbol-Erklärungen
 Das Symbol mit dem Ausrufezeichen im Dreieck weist auf wichtige Informationen in dieser 

Bedienungsanleitung hin. Lesen Sie diese Informationen immer aufmerksam.

	 Das	Pfeilsymbol	weist	auf	besondere	Informationen	und	auf	Ratschläge	zur	Bedienung	hin.	

3. Bestimmungsgemäße Verwendung
Das Produkt gibt über eine USB 2.0-Verbindung ein vergrößertes Bild an Ihren Computer aus und eignet sich für die 
Untersuchung	von	festen	Objekten	wie	Münzen,	Briefmarken,	Steine,	Insekten,	Pflanzen,	Textilien,	Leiterplatten	usw.	
Dimmbare	eingebaute	LED-Leuchten	sorgen	für	Helligkeit	und	die	im	Lieferumfang	befindliche	Software	erlaubt	dem	
Benutzer, das Mikroskop zu kalibrieren, gespeicherte Bilder zu bearbeiten und zu messen. 
Das Gerät ist nur für den Innengebrauch geeignet. Nicht im Freien verwenden. Der Kontakt mit Feuchtigkeit, z. B. im 
Badezimmer, ist unbedingt zu vermeiden.
Aus Sicherheits- und Zulassungsgründen dürfen Sie dieses Produkt nicht umbauen und/oder verändern. Falls Sie das 
Produkt für andere als die zuvor genannten Zwecke verwenden, könnte das Produkt beschädigt werden. Darüber hinaus 
kann eine unsachgemäße Verwendung zu anderen Gefahren führen. Lesen Sie sich die Bedienungsanleitung genau durch 
und	bewahren	Sie	diese	auf.	Reichen	Sie	das	Produkt	nur	zusammen	mit	der	Bedienungsanleitung	an	dritte	Personen	weiter.
Alle	enthaltenen	Firmennamen	und	Produktbezeichnungen	sind	Warenzeichen	der	jeweiligen	Inhaber.	Alle	Rechte	vorbehalten.
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4. Lieferumfang
• Hauptgerät mit USB-Kabel
• Standfuß
• Kalibrierlineal
• Bedienungsanleitung

Aktuelle Bedienungsanleitungen            
Laden Sie aktuelle Bedienungsanleitungen über den Link www.conrad.com/downloads herunter 
oder	scannen	Sie	den	abgebildeten	QR-Code.	Befolgen	Sie	die	Anweisungen	auf	der	Webseite.

5. Eigenschaften und Funktionen
• 20 x – 200 x variable Vergrößerung
• Kamera:	5,0	Megapixel	(Hardwareauflösung)
• Fokusbereich 10 - 100 mm 
• Video-Bildrate 30 fps
• 8 x LED / einstellbare Helligkeit (max. 500 Lux)
• mit Windows® und MacOS kompatibel
• Software: MicroCapture Plus

6. Systemvoraussetzung
• Betriebssystem: Windows® 7/8/10; Mac OS 10.12 oder höher
• CPU: Pentium 300 oder kompatibler AMD-Prozessor 
• 100 MB freier Festplattenspeicher
• 512	MB	RAM
• 24-Bit-Grafikkarte
• Freier USB 2.0-Anschluss
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7. Sicherheitsanweisungen
Lesen Sie die wichtigen Informationen und die Bedienungsanleitung sorgfältig durch und beachten 
Sie insbesondere die Sicherheitshinweise. Falls Sie die Sicherheitshinweise und Informationen 
für einen ordnungsgemäßen Gebrauch in dieser Bedienungsanleitung nicht beachten, haften 
wir nicht für möglicherweise daraus resultierende Verletzungen oder Sachschäden. Außerdem 
erlischt in solchen Fällen die Gewährleistung/Garantie.

a) Allgemein
• Das Produkt ist kein Spielzeug. Halten Sie es von Kindern und Haustieren fern.
• Lassen Sie das Verpackungsmaterial nicht achtlos liegen. Dieses könnte für Kinder zu einem 

gefährlichen Spielzeug werden.
• Schützen Sie das Produkt vor extremen Temperaturen, direkter Sonneneinstrahlung, starken 

Erschütterungen, hoher Luftfeuchtigkeit, Feuchtigkeit, brennbaren Gasen, Dampf und Lösungsmitteln.
• Setzen Sie das Produkt keiner mechanischen Beanspruchung aus.
• Wenn kein sicherer Betrieb mehr möglich ist, nehmen Sie das Produkt außer Betrieb und schützen Sie es vor 

unbeabsichtigter Verwendung. Der sichere Betrieb ist nicht mehr gewährleistet, wenn das Produkt:
 - sichtbare Schäden aufweist, 
 - nicht mehr ordnungsgemäß funktioniert 
 - über einen längeren Zeitraum unter ungünstigen Umgebungsbedingungen gelagert wurde oder 
 - erheblichen Transportbelastungen ausgesetzt wurde.

• Gehen Sie vorsichtig mit dem Produkt um. Stöße, Schläge oder sogar das Herunterfallen aus geringer 
Höhe können das Produkt beschädigen.

• Beachten Sie auch die Sicherheitshinweise und Bedienungsanleitungen der übrigen Geräte, an die das 
Produkt angeschlossen wird.

• Wenden Sie sich an einen Experten, wenn Sie Zweifel an der Funktion, Sicherheit oder in Bezug auf den 
Anschluss des Produkts haben.

• Wartung,	 Modifikationen	 und	 Reparaturen	 dürfen	 nur	 von	 einem	 Techniker	 oder	 einer	 autorisierten	
Reparaturwerkstatt	durchgeführt	werden.

• Sollten Sie noch Fragen haben, die in dieser Bedienungsanleitung nicht beantwortet werden, wenden 
Sie sich an unseren technischen Kundendienst oder an andere Fachleute.

• Achtung, LED-Licht:
 - Nicht direkt in das LED-Licht blicken!
 - Nicht direkt oder mit optischen Instrumenten in den Strahl sehen!

• In Schulen, Ausbildungsstätten, Hobby- oder Selbstbedienungswerkstätten muss der Umgang mit 
elektrischen Geräten durch geschultes Personal überwacht werden.

• Bei Betrieb in gewerblichen Einrichtungen sind die einschlägigen Unfallverhütungsvorschriften der 
Berufsgenossenschaften für elektrische Betriebsmittel zu beachten.
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b) Mikroskop
• Untersuchen Sie keine Objekte, die Temperaturen außerhalb des angegebenen Betriebstemperaturbereichs 

des Produkts aufweisen.
• Plötzliche Temperaturänderungen können dazu führen, dass sich im Inneren des Mikroskops Tau bildet 
–	wie	im	kalten	Winter	in	einen	warmen	Raum.	Legen	Sie	es	in	eine	Handtasche	oder	eine	Plastiktüte,	
um Temperaturänderungen zu verlangsamen.

• Richten	Sie	das	Objektiv	des	Mikroskops	nicht	 lange	auf	die	Sonne	oder	starkes	Licht.	Starkes	Licht	
kann	die	lichtempfindliche	Elektronik	beschädigen.

• Setzen Sie die Karte nicht mit Gewalt in den Steckplatz ein, da dies das Mikroskop und die microSD-
Speicherkarte beschädigen kann. 

• Der	Standfuß	des	Mikroskops	kann	Spuren	auf	empfindlichen	Oberflächen	hinterlassen.

c) Kabel
• Stellen Sie sicher, dass beim Aufstellen das Kabel nicht gequetscht, geknickt oder durch scharfe Kanten 

beschädigt wird.
• Verlegen Sie Kabel immer so, dass niemand über diese stolpern oder an ihnen hängen bleiben kann. 

Es besteht Verletzungsgefahr.

d) Schutz vor Staub
• Staub und Ablagerungen aus der Luft können zu einer Verschlechterung der Bildqualität führen. Halten 

Sie das Mikroskop von staubigen Umgebungen fern.
• Die Öffnung des Kameraobjektivs sollte immer entweder mit Staubschutzhauben o. ä. bedeckt werden. 

Geeignete Optionen sind z. B. Aluminiumfolie oder Plastikbeutel.
• Wenn dunkle Flecken oder ähnliche Partikel auf den digitalen Bildern zu sehen sind und diese sich nicht 
Probenplatte	 befinden,	 ist	 die	wahrscheinlichste	Ursache	 dafür	 eine	 Partikelverunreinigung	 auf	 dem	
Bildsensor	oder	einer	zugeordneten	Filteroberfläche.	Die	Kameras	müssen	nach	den	Empfehlungen	des	
Herstellers immer mit größter Sorgfalt behandelt und vor Verschmutzung geschützt werden.

• Überprüfen Sie vor jedem Einsatz die Frontlinse des Objektivs auf Verschmutzung.
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8. Bedienelemente
A1

A2

A3 A4 A6

A5

A7
A8

A10

A11

A12
A13

A9

A1 USB-Kabelführung
A2 LED Helligkeitsregelung
A3 Verriegelung des Grobfokussierens
A4 Grobfokussierrad
A5 Verriegelung des Mikroskophalters
A6 Feinfokussierrad
A7 LED-Lichtquelle / Kameraobjektiv

A8 Halter mit Halterclips
A9 USB 2.0 Typ-A-Kabel
A10 Arretierung der Armhöhenverstellung
A11 Säule
A12 Befestigungsschraube der Säule
A13 Standfuß

9. Einrichten des Mikroskops
	 Nehmen	Sie	das	Mikroskop	vorsichtig	aus	der	Verpackung	und	stellen	Sie	es	auf	einer	stabilen,	flachen	
Oberfläche	auf.	Der	Standfuß	kann	Spuren	auf	empfindlichen	Oberflächen	hinterlassen.	Stellen	Sie	sicher,	
dass die Säule (A11) vollständig eingesetzt und mit der Säulenbefestigungsschraube (A12) gesichert ist.
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10. Scharfstellen des Mikroskops
 Decken Sie das Mikroskop nicht ab, wenn es in Gebrauch ist.

• Legen Sie das zu untersuchende Objekt auf die Ablage (A8) . Wenn Sie Dias oder ähnliches anschauen wollen, 
befestigen Sie sie mit den Clips auf der Ablage. 

• Halten Sie das Grobfokussierrad (A4) fest und lösen Sie die Verriegelung des Grobfokussierens (A3).
• Drehen Sie das Grobfokussierrad (A4), um das Objektiv zum Objekt hin abzusenken.
• Stellen Sie das Feinfokussierrad (A6) ein, um das Bild scharf zu stellen.
• Abhängig von der Größe des Objekts müssen Sie möglicherweise die Armöhe anpassen, indem Sie die Arretierung 

der Armhöhenverstellung (A10) lösen, die Position anpassen und dann erneut festziehen.

 Es kann einige Augenblicke dauern, bis der Weißabgleich sich automatisch einstellt und das Bild scharf 
stellt.	Wenn	das	Objekt	zu	stark	reflektiert,	sollten	Sie	die	LED-Helligkeit	verringern	(A2) oder vollständig 
ausschalten.
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11. Verbindung des Mikroskops mit einem Computer
• Verbinden Sie das USB 2.0-Kabel des Mikroskops (A9) mit einem freien USB 2.0-Anschluss an Ihrem Computer.
• Sie können das lose Kabel an der USB-Kabelführung (A1) befestigen.

12. Herunterladen und Installation der Software
a) Windows®

1. Rufen	Sie	die	URL-Adresse	www.conrad.com/downloads auf. 
2. Geben Sie dann die Artikelnummer 1713198 in das Suchfeld ein.
3. Wählen Sie MicroCapture Plus aus, um die Software zu installieren, und befolgen Sie dann die Anweisungen auf 

dem Bildschirm, um den Installationsvorgang abzuschließen.
4. Führen Sie die Software aus, indem Sie auf das nach der Installation auf dem Desktop erstellte MicroCapture 

Plus-Symbol klicken.

  Ändern Sie ggf. die Anzeigesprache, z. B. Options (Optionen) > Language (Sprache) > English 
(Englisch).

b) MacOS
1. Rufen	Sie	die	URL-Adresse	www.conrad.com/downloads auf. 
2. Geben Sie dann die Artikelnummer 1713198 in das Suchfeld ein.
3. Wählen Sie die Datei MicroCapture Plus.pkg aus.
4. Befolgen Sie die Anweisungen auf dem Bildschirm, um den Installationsvorgang abzuschließen.
5. Führen Sie die Software aus, indem Sie auf das nach der Installation auf dem Desktop erstellte MicroCapture 

Plus-Symbol klicken.
  Ändern Sie ggf. die Anzeigesprache, z. B. Options (Optionen) > Language (Sprache) > English 

(Englisch).
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13. MicroCapture Plus Software
a) Übersicht

B1
B2

B3

B4

B5

B6

B7

B1 Menüpunkte
 - File (Datei) > Photos oder Videos Folder (Foto- oder Video-Ordner): Ort der aufgenommenen Bilder
 - Options (Optionen) > Resolution (Auflösung):	Ändern	der	Auflösung	der	aufgenommenen	Bilder
 - Options (Optionen) > Date /Time (Datum/Uhrzeit): Ein-/Ausblenden des Datums-/Uhrzeitstempel auf einem 

Foto oder in einem Video
 - Options (Optionen) > Language (Sprache):	Einstellen	der	Sprache	für	die	Benutzeroberfläche
 - Options (Optionen) > XY Guide (XY-Hilfslinien): Hilfslinien anzeigen/ausblenden

B2 Shortcuts: Kamera / Video / Timer / Vollbild

 
Wechseln Sie in den Vollbildmodus oder beenden Sie ihn, indem Sie auf den Vorschaubereich doppelklicken oder 
das Vollbild-Symbol auswählen.

B3 X- und Y-Achsen-Hilfslinien
B4 Bildvorschaubereich
B5 Vergrößerungsinformationen
B6 Foto/Video-Registerkarte:	Wählen	Sie	eine	Registerkarte	aus,	um	gespeicherte	Fotos	oder	Videos	anzuzeigen.
B7 Fenster für gespeicherte Bilder (Miniaturansicht)

 - Aufgenommene Bilder/Videos werden als Miniaturansichten angezeigt.
 - Wenn Sie mit der Maus über eine Miniaturansicht fahren, wird das Bild im Vorschaubereich angezeigt (B4).
 - Klicken Sie mit der rechten Maustaste auf ein Bild, um weitere Optionen anzuzeigen, z. B. Open (Öffnen), Save 

as (Speichern unter), Copy (Kopieren), Delete (Löschen), Delete All (Alle löschen).
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b) Fotos aufnehmen 
• Stellen Sie das Mikroskop so ein, dass das Kameraobjektiv (A7) nahe am Objekt liegt und auf dieses zeigt.
• Stellen	Sie	sicher,	dass	sich	das	zu	untersuchende	Objekt	unter	dem	Objektiv	befindet.
• Während Sie den Bildvorschaubereichs (B4) betrachten, stellen Sie das Bild scharf.

• Um ein Bild aufzunehmen, wählen Sie den Kamera-Shortcut  oder drücken Sie die Schnappschuss-Taste.
• Die Fotos werden in File (Datei) > Photos Folder (Fotoordner) gespeichert.

 Aufgenommene Bilder werden als Miniaturansichten im Fenster für gespeicherte Bilder angezeigt (B7). 
Wenn Sie mit der Maus über eine Miniaturansicht fahren, wird das Bild im Vorschaufenster angezeigt. 
Bilder werden im JPG-Format gespeichert.

c) Videos aufnehmen
• Stellen Sie das Mikroskop so ein, dass das Kameraobjektiv (A7) nahe am Objekt liegt und auf dieses zeigt.
• Stellen	Sie	sicher,	dass	sich	das	zu	untersuchende	Objekt	unter	dem	Objektiv	befindet.
• Während Sie den Bildvorschaubereichs (B4) betrachten, stellen Sie das Bild scharf.

• Um mit der Aufnahme zu beginnen, klicken Sie auf den Video-Shortcut . Das Symbol blinkt, um anzuzeigen, 
dass die Aufnahme gestartet wurde.

• Klicken Sie auf das blinkende Symbol, um die Aufzeichnung zu stoppen.
• Videos werden in File (Datei) > Photos Folder (Videoordner) gespeichert.

 Aufgenommene Videos werden als Miniaturansichten im Fenster für gespeicherte Bilder angezeigt (B7). 
Wenn Sie mit der Maus über eine Miniaturansicht fahren, wird das Bild im Vorschaufenster angezeigt. 
Videos werden im AVI-Format gespeichert.

d) Foto- und Video-Timer

.

• Sie	können	einen	benutzerdefinierten	Start-	und	Stopptimer	für	die	Aufnahme	
von Fotos oder Videoaufnahmen einstellen.

• Wählen Sie das Timer-Shortcut-Symbol  aus und wählen Sie dann Photo 
(Foto) oder Video.

• Nehmen Sie die gewünschten Einstellungen vor.
• Wählen Sie Start aus, um mit der Aufnahme zu beginnen.

 Die Aufnahme stoppt, nachdem das Programm die Parameter 
durchlaufen hat oder wenn Sie Stop (Stopp) wählen, um den Timer zu 
beenden.
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e) Bildmesswerkzeuge
 Um die Genauigkeit der Messwerkzeuge sicherzustellen, kalibrieren Sie zuerst Ihr Mikroskop. Informationen 
dazu	finden	Sie	im	Abschnitt	„Kalibrieren	des	Mikroskops“.

 Doppelklicken Sie auf ein Bild im Fenster für gespeicherte Bilder (B7), um auf das Menü zum Messen 
zuzugreifen, und wählen Sie dann das Symbol  zum Messen.

• Any Angle Line Measurement (Beliebige Winkellinienmessung). Klicken 
und ziehen Sie von einem Punkt zum anderen.

• Continuous Line Measurement (Kontinuierliche Linienmessung). 
Klicken und ziehen Sie von einem Punkt zu mehreren Punkten.

• Radius Circle Measurement (Radiuskreismessung). Klicken und ziehen 
Sie,	um	den	Radius	zu	vergrößern.

• Diameter Circle Measurement (Durchmesserkreismessung). Klicken und 
ziehen Sie, um den Durchmesser zu vergrößern.

• Three Points Angle Measurement (Drei-Punkte-Winkelmessung). Klicken 
und ziehen Sie von einem Punkt zum anderen, messen Sie den Winkel, und 
klicken Sie dann mit der Maus, um loszulassen. 

f) Zeichnen und Text
 Doppelklicken Sie auf ein Bild im Fenster für gespeicherte Bilder (B7),	um	die	Oberfläche	für	Bildmarkierung/

Kommentare aufzurufen, und wählen Sie dann das Symbol  zum Zeichnen aus.
• Ein Dropdown-Menü mit verschiedenen Optionen wird angezeigt.

• In den Line Properties (Linieneigenschaften) können Line Width 
(Linienbreite) und Line Color (Linienfarbe) angepasst werden.

• Wählen Sie das Text-Symbol  aus.
• Ein Dropdown-Menü mit verschiedenen Optionen wie Schriftart und 

Textfarbe wird angezeigt.
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14. Kalibrieren des Mikroskops
• Fokussieren Sie das Mikroskop auf das Kalibrierungslineal.
• Drehen Sie den Feintrieb, bis das Bild scharf wird. 

• Stellen Sie die Position des Mikroskops ein, dass das 
Bild auf die XY-Hilfslinien ausgerichtet ist.

 Doppelklicken Sie auf ein Bild im Fenster für gespeicherte Bilder (B7) , um die um auf das Menü zum 
Messen zuzugreifen, und wählen Sie dann das Symbol  zum Kalibrieren.

• Klicken und ziehen Sie, um Start- und Endpunkte 
über einen bekannten Wert zu wählen, z. B. 1 mm-
Abschnitte auf dem Lineal.

• Wenn das Dialogfeld angezeigt wird, geben Sie den 
genauen Wert der Messprobe in das Feld Actual 
dimension (Tatsächliche Länge) ein. Die Software 
kalibriert die Vergrößerung. 

• Drücken Sie zur Bestätigung auf OK. Der eingestellte 
Vergrößerungswert wird in der oberen rechten Ecke 
angezeigt.



14

15. Starke und geringe Vergrößerung
• Hohe Vergrößerung (1,5 mm Sichtfeld): Drehen Sie das Feinfokussierrad (A6) ganz nach rechts und drehen Sie 

dann langsam zurück, bis das Bild scharfgestellt ist.
• Geringe Vergrößerung (6 mm Sichtfeld): Drehen Sie das Feinfokussierrad (A6) ganz nach links und drehen Sie 

dann langsam zurück, bis das Bild scharfgestellt ist.

 Nachdem Sie den Feintrieb (A6) ganz nach rechts oder links gedreht haben, dauert es einige Sekunden, 
bis sich die LED-Beleuchtung wieder korrekt eingestellt hat.

16. Pflege und Reinigung
• Trennen	Sie	das	Produkt	vor	jeder	Reinigung	von	Ihrem	Computer.	Wenn	es	heiß	ist,	warten	Sie,	bis	es	abgekühlt	

ist.
• Verwenden	Sie	keine	aggressiven	Reinigungsmittel,	Alkohol	oder	andere	chemischen	Lösungsmittel,	da	diese	zu	

Schäden am Gehäuse und zu Fehlfunktionen führen können.
• Die LED-Beleuchtung ist nicht austauschbar.
• Vermeiden	 Sie	 es,	 die	 Linse	 mit	 irgendwelchen	 Stoffen	 zu	 berühren.	 Reinigen	 Sie	 die	 Linse	 regelmäßig	 mit	

niedrigerer Druckluft.
• Verwenden	Sie	zum	Reinigen	des	Produkts	ein	trockenes,	faserfreies	Tuch.

17. Entsorgung
 Elektronische Geräte sind recyclingfähig und dürfen nicht im Hausmüll entsorgt werden. Entsorgen Sie 

das Produkt am Ende seiner Lebensdauer gemäß den geltenden gesetzlichen Bestimmungen. Sie erfüllen 
damit	die	gesetzlichen	Verpflichtungen	und	leisten	Ihren	Beitrag	zum	Umweltschutz.
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18. Technische Daten
Betriebsspannung .............................................5 V / DC, 1 A (über USB 2.0)
Verbindung .......................................................USB 2.0 (Typ A)
Bildsensor .........................................................5	MP	(Hardwareauflösung)
Video	/	Standbildauflösung ...............................2592x1944, 2320x1744, 2048x1536, 1920x1080, 1280x1024 Pixel
Fokusbereich ....................................................0 mm bis 150 mm (manueller Fokus)
Vergrößerung ....................................................20 x – 200 x
Bildformat .........................................................JPG
Videoformat ......................................................AVI
Weißabgleich  ...................................................Automat
Lichtquelle LED
Betriebsbedingungen .............................................0 bis +70° C, 25 bis 50 % relative Luftfeuchtigkeit (nicht kondensierend)
Lagerbedingungen .................................................-5 bis +50 °C, 25 bis 50 % relative Luftfeuchtigkeit (nicht kondensierend)
Unterstützte Betriebssysteme ...........................Windows® 7/8/10; Mac OS 10.12 oder höher
Abmessungen Kamera (Ø x L) .........................33 mm x 110 mm
Abmessungen Standfuß (L x B x H) .................165 x 118 x 12 mm 
Gewicht .............................................................1 kg
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1. Introduction
Dear customer,
Thank you for purchasing this product.
This product complies with the statutory national and European requirements.
To maintain this status and to ensure safe operation, you as the user must observe these operating instructions!

 These operating instructions are part of this product. They contain important notes on commissioning and 
handling. Also consider this if you pass on the product to any third party. Therefore, retain these operating 
instructions for reference!

If there are any technical questions, please contact:
www.conrad.com/contact

2. Explanation of Symbols
 The symbol with the exclamation mark in the triangle is used to indicate important information in these 

operating instructions. Always read this information carefully.

 The arrow symbol indicates special information and advice on operation. 

3. Intended Use
The	product	outputs	a	magnified	image	to	your	computer	via	USB	2.0	connection	and	is	suitable	for	examining	solid	
objects such as coins, stamps, rocks, insects, plants, textiles, circuit boards, etc. Dimmable built-in LED lights provide 
brightness, and the bundled software allow the user to calibrate the microscope, edit and measure saved images. 
It is intended for indoor use only. Do not use it outdoors. Contact with moisture, e.g. in bathrooms, must be avoided 
under all circumstances.
For safety and approval purposes, you must not rebuild and/or modify this product. If you use the product for purposes 
other than those described above, the product may be damaged. In addition, improper use can result in other hazards. 
Read	the	instructions	carefully	and	store	them	in	a	safe	place.	Make	this	product	available	to	third	parties	only	together	
with its operating instructions.
All company names and product names are trademarks of their respective owners. All rights reserved.
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4. Delivery Content
• Main unit with USB cable
• Base
• Calibration ruler
• Operating instructions

Up-to-Date Operating Instructions            
Download the latest operating instructions at www.conrad.com/downloads	or	scan	 the	QR	code	
shown. Follow the instructions on the website.

5. Features and Functions
• 20x	-	200x	variable	magnification
• Camera: 5.0 megapixels (true)
• Focus range 10 - 100 mm 
• Video frame rate 30 fps
• 8 x LED / adjustable brightness (max. 500 lux)
• Windows®, Mac OS compatible
• Software: MicroCapture Plus

6. System Requirements
• OS: Windows® 7/8/10; Mac OS 10.12 or above
• CPU: Pentium 300 or compatible AMD Processor 
• 100 MB free hard disc space
• 512	MB	RAM
• 24-bit video card
• Available USB 2.0 port
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7. Safety Instructions
Read the important information and operating instructions carefully and especially observe 
the safety information. If you do not follow the safety instructions and information on proper 
handling, we assume no liability for any resulting personal injury or damage to property. Such 
cases will invalidate the warranty/guarantee.

a) General
• The device is not a toy. Keep it out of the reach of children and pets.
• Do not leave packaging material lying around carelessly. This may become dangerous playing material 

for children.
• Protect the device from extreme temperatures, direct sunlight, strong jolts, high humidity, moisture, 
flammable	gases,	steam	and	solvents.

• Do not place the product under any mechanical stress.
• If it is no longer possible to operate the product safely, take it out of operation and protect it from any 

accidental use. Safe operation can no longer be guaranteed if the product:
 - is visibly damaged, 
 - is no longer working properly, 
 - has been stored for extended periods in poor ambient conditions or 
 - has been subjected to any serious transport-related stresses.

• Please handle the product carefully. Jolts, impacts or a fall even from a low height can damage the 
product.

• Also observe the safety and operating instructions of any other devices which are connected to the 
product.

• Consult an expert when in doubt about the operation, safety or connection of the device.
• Maintenance,	modifications	and	repairs	must	only	be	completed	by	a	technician	or	an	authorised	repair	

centre.
• If you have questions which remain unanswered by the operating instructions, contact our technical 

support service or other technical personnel.
• Attention, LED light:

 - Do not look directly into the LED light!
 - Do not look into the beam directly or with optical instruments!

• In schools, training facilities, hobby or self-service workshops, handling of electrical devices must be 
monitored by trained personnel.

• When operating on commercial premises, the relevant accident prevention regulations of workers’ 
compensation boards for electrical equipment must be observed.
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b) Microscope
• Do not examine objects with temperatures outside the given operating temperature range of the product.
• Sudden temperature change may form dew inside the Microscope like entering a warm room in cold 

winter. Put it inside a handbag or plastic bag to slow down temperature changes.
• Do not point Microscope lens to the sun or strong light for a long time. Powerful light may damage the 

light-sensitive electronics.
• Do not force the card into the slot as this may damage the microscope and the MicroSD memory card. 
• The base of the microscope may leave marks on sensitive surfaces.

c) Cable
• When setting up the product, make sure that the cable is not pinched, kinked or damaged by sharp 

edges.
• Always lay the cables so that nobody can trip over or become entangled in them. This poses a risk of 

injury.

d) Protection Against Dust
• Dust and debris from the air can lead to deterioration of image quality. Keep the Microscope away from 

dusty environments.
• The opening of the camera lens should always be protected either with dust covers such. Suitable 

options include aluminium foil or plastic bags.
• If dark specks or similar in-focus artifacts are observed in digital images, and they are not in the specimen 
plane,	their	most	likely	cause	is	particulate	contamination	on	the	image	sensor	or	an	associated	filter	
surface. The cameras always need to be handled with the utmost care and protected from dirt according 
to the manufacturer‘s recommendations.

• Before every critical use, check the front lens of the objective for dirt.
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8. Operating Elements
A1

A2

A3 A4 A6

A5

A7
A8

A10

A11

A12
A13

A9

A1 USB Cable guide
A2 LED brightness adjuster
A3 Coarse focus lock
A4 Coarse focus dial
A5 Microscope holder lock
A6 Fine focus dial
A7 LED light source / camera lens

A8 Stage with stage clips
A9 USB 2.0 Type-A cable
A10 Arm height adjustment lock
A11 Column
A12 Column attachment screw
A13 Base

9. Setting Up the Microscope
	 Gently	take	the	microscope	out	of	the	packaging	and	place	onto	a	stable	flat	surface.	The	base	of	the	stand	

may leave marks on sensitive surfaces. Make sure the column (A11) is fully inserted and secured using the 
column attachment screw (A12).
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10. Focus the Microscope
 Do not cover the microscope when it is in use.

• Place the object to be examined onto the stage (A8). If observing slides or similar, insert under the stage clips. 
• While holding the coarse focus dial in place (A4), release the coarse focus lock (A3).
• Rotate	the	coarse	focus	dial	(A4) to lower the lens towards the object.
• Adjust	the	fine	focus	dial	(A6) to bring the image into sharp focus.
• Depending on the size of the object, you may need to adjust the arm height by releasing the arm height adjustment 

lock (A10), adjusting the position, then tightening it again.

 It may take a few moments for the white balance to auto adjust and bring the image into focus. If there is 
too	much	reflection	from	the	object,	consider	lowering	the	LED	brightness	(A2) or turning it off completely.
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11. Connect Microscope to Computer
• Connect the microscope USB 2.0 cable (A9) to an available USB 2.0 port on your computer.
• Tidy up the loose cable by clipping it into the USB cable guide (A1).

12. Download and install software
a) Windows®

1. Visit: www.conrad.com/downloads .
2. Enter item number 1713198 .
3. Select MicroCapture Plus to install the software, then follow the on-screen instructions to complete the installa-

tion process.
4. Run	the	software	by	clicking	the	MicroCapture Plus icon generated on the desktop after installation.

 If needed change the display language e.g. Options > Language > English.

b) Mac OS
1. Visit: www.conrad.com/downloads .
2. Enter item number 1713198.
3. Select	the	file	MicroCapture Plus.pkg	file.
4. Follow the on screen instructions to complete the installation process.
5. Run	the	software	by	clicking	the	MicroCapture Plus icon generated on the desktop after installation.

 If needed change the display language e.g. Options > Language > English.
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13. MicroCapture Plus Software
a) Overview

B1
B2

B3

B4

B5

B6

B7

B1 Menu items
 - File > Photos or Videos Folder: Captured images location.
 - Options > Resolution: Change image capture resolution.
 - Options > Date /Time: Show/hide the recorded date and time in photo or video.
 - Options > Language: Change user interface language.
 - Options > XY Guide: Show/hide guidelines.

B2 Shortcuts: Camera / Video / Timer / Full Screen.

 
Enter / exit full screen mode by double-clicking the preview area or selecting the full screen icon.

B3 X and Y axis guidelines.
B4 Image preview area.
B5 Magnification	information.
B6 Photo / Video tab: Select a tab to view saved Photos or Videos.
B7 Saved images window (thumbnail view).

 - Captured images / videos show up as thumbnails.
 - If you hover the mouse over a thumbnail, the image will show in the preview area (B4).
 - Right	mouse	click	an	image	for	further	options	such	as	Open, Save as, Copy, Delete, Delete All.
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b) Take Photo 
• Adjust the microscope so that the camera lens (A7) is close to and pointing at the object.
• Make sure the object to be examined is centered under the lens.
• While observing the image preview area (B4), bring the image into focus.

• To capture the image select the camera shortcut  icon, or press the snapshot button.
• Photos will be stored in File > Photos Folder.

 Captured images show as thumbnails in the saved images window (B7). If you hover the mouse over a 
thumbnail, the image will show in the preview window. Images are stored in the JPG format.

c) Record Videos
• Adjust the microscope so that the camera lens (A7) is close to and pointing at the object.
• Make sure the object to be examined is centered under the lens.
• While observing the image preview area (B4), bring the image into focus.

• To start recording click on the Video shortcut .The	icon	will	flash	to	indicate	recording	has	started.
• Click	the	flashing	icon	to	stop	recording.
• Videos will be stored in File > Videos Folder.

 Captured videos show as thumbnails in the saved images window (B7). If you hover the mouse over a 
thumbnail, the image will show in the preview window. Videos are stored in the AVI format.

d) Photo and Video Timer

.

• You can set a custom start and stop timer for capturing photos or recording 
video.

• Select the Timer shortcut , then choose Photo or Video.
• Set your desired parameters.
• Select Start, to begin recording.

	 Recording	will	stop	after	the	program	has	run	through	the	parameters,	
or if you select Stop to end the timer.
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e) Image Measuring Tools
	 For	measuring	tools	to	be	accurate,	first	calibrate	your	microscope.	See	section	“Calibrating	Microscope”	

for information about how to do this.

 Double-click an image in the saved images window (B7) to enter the measurement interface, then select 
the measure  icon.

• Any Angle Line Measurement. Click and drag from one point to another.
• Continuous Line Measurement. Click and drag from one point to multiple 

points.
• Radius Circle Measurement. Click and drag to extend the radius.
• Diameter Circle Measurement. Click and drag to extend the diameter.
• Three Points Angle Measurement. Click and drag from one point to 

another, measure the angle, then click the mouse to release. 

f) Draw and Text
 Double-click an image in the saved images window (B7) to enter the Image Markup / Comment interface, 

then select the draw  icon.
• A dropdown menu will show with various options.

• Line Properties include Line Width and Line Color.

• Select the text  icon.
• A dropdown menu will show with various options such as font selection and 

text color.
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14. Calibrating the Microscope
• Focus the microscope on the calibration ruler.
• Rotate	the	fine	focus	dial	until	the	picture	becomes	sharp.	

• Adjust the microscope position so the image is lined 
up square with the XY guides.

 Double-click an image in the saved images window (B7) to enter the measurement interface, then select 
the calibration  icon.

• Click and drag to select start and end points across 
a known value e.g. 1 mm increment along the ruler.

• When the dialog box shows, enter the exact value of 
the measurement sample in the Actual dimension 
field.	The	software	will	calibrate	the	magnification.	

• Select OK to	 confirm.	 The	 adjusted	 magnification	
value will show in the upper right corner.

15. High and Low Magnification
• High	magnification	(1.5	mm	field	of	view):	Turn	the	fine	focus	dial	(A6) all the way to the right, then slowly dial back 

until the image comes into focus.
• Low	magnification	(6	mm	field	of	view):	Turn	the	fine	focus	dial	(A6) all the way to the left, then slowly dial back until 

the image comes into focus.

	 After	turning	the	fine	focus	dial	(A6) all the way right or left, it will take a few seconds for the LED light 
balance to adjust.
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16. Care and Cleaning
• Disconnect the product from your computer before each cleaning. If it is hot, wait for it to cool down.
• Do not use any aggressive cleaning agents, rubbing alcohol or other chemical solutions as they can cause damage 

to the housing and malfunctioning.
• The LED lights are not replaceable.
• Avoid touching the lens with any substance. Clean the lens periodically with low pressure compressed air.
• Clean	the	product	with	a	dry,	fibre-free	cloth.

17. Disposal
 Electronic devices are recyclable and must not be disposed of in the household waste. At the end of its 

service	life,	dispose	of	the	product	in	accordance	with	applicable	regulatory	guidelines.	You	thus	fulfill	your	
statutory obligations and contribute to the protection of the environment.

18. Technical Data
Operating voltage .............................................5 V/DC, 1 A (via USB 2.0)
Connection .......................................................USB 2.0 (Type A)
Image sensor ....................................................5 MP (true)
Video / still capture resolution ...........................2592x1944, 2320x1744,2048x1536,1920x1080, 1280x1024 Pixel
Focus range ......................................................0 mm to 150 mm (manual focus)
Magnification ....................................................20x - 200 x
Image format ....................................................JPG
Video format .....................................................AVI
White balance ...................................................Automatic
Light Source .....................................................LED
Operating conditions .........................................0 to +70 °C; 25 - 50 % relative humidity (non-condensing)
Storage conditions ............................................-5 to +50 °C; 25 - 50 % relative humidity (non-condensing)
Supported operating systems ...........................Windows® 7/8/10; Mac OS 10.12 or above
Dimensions camera (Ø x L) ..............................33 mm x 110 mm
Dimensions stand (L x W x H) ..........................165 x 118 x 12 mm 
Weight ...............................................................1 kg
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